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1.00 Introduction

Welcome to the M Arch at the Welsh School of Architecture. This course handbook provides details of
the important things you need to know when studying for your degree at the school. This handbook
should be read in conjunction with the school's Teaching Handbook, which describes some of the
processes and practices that the school undertakes in terms of how we teach and assess. It should
also be read in conjunction with the supplementary information issued at the start of each academic
year. This information will contain descriptions of the modules you will be undertaking during that year
and specific information related to that particular year. There are also a series of rules and regulations
that govern how we run the course. Some of these are determined centrally by the university, others
by the school itself. The school regulations and examining board conventions are included in the
appendix to this document.

It is important that you read this handbook and are aware of the contents of the associated
documents. You should also ensure that you keep a copy of this handbook once you have completed
the course, as occasionally employers request details to support a job application.

If you have any queries or feel that there are any omissions please feel free to discuss them at the
numerous year meetings and briefings that are held throughout the year. If you have any queries
about the factual content, or scheme regulations please do not hesitate to contact Susan Morgans or
Kate Docker (Room 2.58)
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2.00 The M Arch Degree

The M Arch (Master of Architecture) is a two-year degree scheme, taken after the BSc (or equivalent
qualification from another university). It satisfies Part 2 of the UK professional qualification for
architects, and is approved by the RIBA and ARB. The first year of the M Arch - the Year of Education
in Practice - is spent predominantly in architectural practice. It includes three short courses, held in the
School, and has a modular structure of associated coursework. The second year of the M Arch is
spent full-time in the School and takes students to an advanced level of architectural design. It offers
an intense and lively forum for the exploration and discussion of contemporary issues in architecture,
and also includes courses in building economics and professional practice.

Master of Architecture : Modular Structure
Autumn Semester

MArch Year 1

EDUCATION IN PRACTICE

DESIGN & TECHNOLOGY IN PRACTICE: 10 credits

Critical apraisal of scheme in practice
Technology in concept, strategy and detail

Spring Semester

RESEARCH METHODS: 10 credits
Preparation for dissertation - scope, aims and objectives methodologies
Critical readings and appraisals and literature review

PROJECT INITIATION: 20 Credits

Economic determinants of development in practice

Practical investigation of development economics through
design

MANAGEMENT AND COMMUNICATION: 10 credits
Organisational theory and behaviour in practice

Management and communication in the design office in practice

MArch Year 2
DESIGN THESIS AND DISSERTATION
WRITTEN DISSERTATION: 30 Credits

Critical study of selected aspect of architecture
Conducted thro research inc methodology, results and findings

Continuity of skills

The M Arch is a research-and practice-led
degree focussing on developing each
graduate’s skills in independent thinking. Every
candidate is expected to exercise initiative and
personal responsibility and teaching is
concentrated on supporting this aim. Skills in
library and field research, appraisal, analysis
and interpretation are developed in all M Arch
modules.

The course involves development of skills,
knowledge and experience through reflective
practice. M Arch 1 modules ‘Practice
Experience’ and ‘Design and Technology in
Practice’ require graduates to critically

Graduates write brief

appraise the activities and methods of their
architectural office according to their academic
experience, and encourage the graduate to
reflect on their teaching according to their
practical experience. Reflective practice in
formal research is enabled through the
‘Research Methods’ and ‘Dissertation’ modules
which combine to develop a piece of written
work through both years of the degree. Design
skills, and the promotion of design as a
reflective activity, are strengthened through the
‘Design in Practice’ module and fully
developed in the ‘Design Thesis’ with
individual interviews concentrating on helping
the graduate to define their interests into a
coherent design thesis.
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Continuity of content

The M Arch degree enables graduates to
develop their own frameworks for architecture.
Graduates are encouraged to evolve their
position into a coherent thesis in M Arch 2:
through ‘Design in Practice’ to ‘Design Thesis’;
and through ‘Research Methods’ to
‘Dissertation’. It is recognised that this won’t
necessarily be a linear process. However,
students are encouraged and supported to
develop their research through these modules
towards a cohesive design proposition at the
end of M Arch 2.

Within this broad context, there are a number
of specific content connections. ‘Design in
Practice’ in M Arch 1 develops skills toward
‘Design Thesis’. ‘Project Initiation’ in M Arch 1
informs brief writing in ‘Design Thesis’.
‘Research Methods’ enables students to
develop critical tools and synthesise content
toward their ‘Dissertation’. ‘Practice
Experience’ and ‘Management and
Communication’ in M Arch 1 set up themes
developed in ‘Practice Management and
Economics’ in M Arch 2. The economic aspect
of ‘Project Initiation’ informs the same M Arch
2 module and is developed through individual
economics consultancies and examinations in
‘Design Thesis’. ‘Design and Technology in
Practice’ also provides a background for
technical investigations as part of the ‘Design
Thesis’.

Education in Practice

MArch1 takes place mostly in architects’
offices. Students return to the school for three
short courses, each lasting one week and
timetabled for September, February and June.
At the Short courses briefings are given for the
six academic modules, students work together
on assignments and seminars enable practice
experience to be shared. Between the short
courses work for the academic modules goes
ahead in parallel with office employment. This
carefully considered dove-tailing of practice
and academic work enables theory and work
on

The projects to be brought together compared
and contrasted. Great importance is attached
to close communications between students
and school. Offices are visited by
representatives of the School, and contact is
maintained through email, post and phone.
While at work in practice students are
encouraged to discuss and compare their work
with each other and with architects in their
offices.

Assessment

M Arch 1 and M Arch 2 modules are assessed
separately. It is a requisite to pass all M Arch 1
modules to progress to M Arch 2.
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3.00 Communications

Contact with staff

Each year group is managed by a Year Chair
and Year Tutor from the full-time academic
staff, assisted by a Professional Tutor and a
team of part-time tutors. Further Details of how
the schemes are organised and the roles of
different members of staff can be found in
section 1 or the Teaching Handbook

A full list of staff in the School, and their roles
can be found on the School’s website.

The School operates an ‘open-door’ policy
where staff are pleased to discuss student
work outside of timetabled teaching events.
This is an important ingredient in the special
atmosphere that exists in the School. However
please note that staff are engaged in research
as well as teaching. They also have quite
onerous administrative duties. Sometimes, if
you have problems, the administrative staff
may also be able to help.

Staff in each year will make you aware of when
they are available for tutorials and for you to
see them about personal or pastoral matters.
Outside those times, please respect their need
for time and peace to make progress on their
own work. Often project briefs and other
documentation contain all of the information
you need: please read them carefully before
guestioning staff unnecessarily. Design
teaching takes place at timetabled events —
centred around the main weekly tutorial or crit.
Times when tutors will be in studio will be
posted on the year notice board.

Year meetings and briefings will be held
regularly. These are important and should be
attended by all students.

You should remember that setting your own
agenda, and deciding your own courses of
action, are part of your education as architects.
Dependency on staff for every design decision
you make is not good for your development.
You are expected to become more self-
directing in your work, and show more
initiative, as you progress through the School.
Itis also helpful to discuss your design work
with your colleagues in the year. Discussing
other people’s ideas — teaching each other —

can be as personally rewarding as working on
your own design.

For appointments to see the Head of School,
Prof. Phil Jones, you will first need to see his
P.A., Anne Evans, EvansA3@cardiff.ac.uk.
You should make yourself familiar with the
location of these offices.

Administrative Staff

You may find that members of the
administrative staff will be able to help you with
certain matters. In addition If there are any
changes to your personal data (eg contact
address or emergency contact details) you can
log on to SIMS Online and make amendments
yourself, or you can correct your academic
data (eg programme of study, modules/units)
by completing a Notification of Change to
Academic Details form, available from the
school reception, Registry, Student Support
Centre and Student Advice and
Representation Centre.

Noticeboards

It is your responsibility to check the notice
board on a daily basis, as this is the primary
source of communication between teaching
staff and the students. They also highlight any
changes to schedules. Each year has its own
notice board on the landing of the second floor
of the Bute Building. This will carry general
information as well as notices from the school
office. These boards not only inform members
of the year but also allow students from other
years to keep in touch with events. You should
get into the habit of seeing what other years
are doing, particularly the announcements of
open lectures and reviews which you should
try to attend.

Notice boards for SAWSA, the Architectural
Library, MSc Research, work opportunities,
plus general information, are located on or
near the landing.

Email

Increasingly we will be emailing you with
project notices and other information. It is very
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important that you check your University
email post-box on a regular basis. We will not
send information to private email addresses.

Mail
Student mail will be placed in drawers at front
of WSA reception

Learning Central

Learning Central is the University’s system for
e-learning. Generally it is used in the School
as a repository for information and as a place
where written work can be submitted.
Learning Central can be accessed at
http://cue.cf.ac.uk/

University Web Portal
(http://mwe.cf.ac.uk)

The University now has a web portal through
which you can access a range of IT facilities
from outside the University. These include
access to your University email, your network
file storage (H & S drives), Learning Central,
on-line collaboration tools, and other electronic
resources. The portal also allows you to
change your password, and set security
questions so that you can retrieve your
password if it gets forgotten.

You can log onto the web portal using your
University network username and password.

Submitting/collecting work

Design project work is typically submitted by
pinning up work in the appropriate location in
the School.

There is a formal system for
submission/collection of written work at the

School. Your tutors will inform you of deadlines
by which written work must be submitted for
marking.

You must submit /collect written work between
9am and 3pm at the School Reception.

To submit written work, you must complete a
receipt, (which is available at the School
Reception). The receipt asks you for the
following details; student name, number,
degree course, year of study, module title, title
of work and signature. This receipt must also
be signed and dated by a member of
administrative staff, as witness to receipt of the
work. This will be Jan O’Brien or Janine Jones
the School Receptionists. You will retain a
copy of the receipt for your records. The other
two copies are attached to your submitted
work for our records. Once the work has been
marked, your tutor will confirm the work is
ready for collection from the School
Receptionist. She will ask you to sign a year
list as confirmation that you have collected the
work. Any work that remains uncollected
after the end of year reviews may be
destroyed.

You may be asked to submit an electronic
PDF copy of your work. This will usually be
to Learning Central, but may be on a CD.
Details will be provided in each project brief.

Late submission is not allowed (except in
cases of illness or some other unavoidable
reason). Students may be penalised, or
receive zero marks if work is not submitted
by the deadline without a bona-fide reason:
Please refer to section 6 of the teaching
handbook for details of the School’s general
policy on the late submission of work.
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4.00 Facilities and Resources

The School Reception

This will be your first point of call for anything
you are uncertain about. You will soon
discover the valuable role which the reception
plays in the School: distributing project briefs
and handouts, receiving illness certificates,
acting as the submission point for your written
papers etc.

The Architecture Library

The architecture library is located within the
School. Its opening hours are posted outside
the door on the 2™ floor landing. On some
occasions the door to the architecture library is
closed, in which case access can be made
through the Bute Library on the 1% floor.
Further information on library policies and
procedures (including fines for returning books
late) will be included in information issued by
information services.

Subscriptions to Journals

We strongly recommend that you subscribe to
the Architects Journal and if possible the
Architectural Review. It is vital that you
become familiar with what is going on in

Contemporary Architecture and the Profession.

The Royal Society of Architects in Wales
(RSAW) offers free membership to students.

You are advised to browse the current journals
rack in the library on a weekly basis

Computers

The Media Lab (2.30) is located off the North
corridor. This is equipped with PC’s, A1
Plotters, scanners and various sizes of printer.
Problems with system software and hardware
should be directed to ArchitecturelT@cf.ac.uk
Open access computer rooms are located
around the University campus, including the
Bute Library. Students who bring laptops to
the School can connect to the University
wireless network, provided they have an
approved virus checker installed on their
computers. Further details can be obtained
from information services.

Food and Refreshments

Sandwiches, drinks etc. can be purchased
from the ground floor coffee shop.

Materials and Reprographics

Graphic Services in the entrance to the Bute
building provide large format Al photocopying
and printing. They also sell drawing paper,
including tracing rolls. Outside the School the
following suppliers also supply materials:

= Blackwells Bookshop: Students Union

= Pen & Paper: Royal Arcade: full
architectural and art supplies, a student
discount is available with a student card.

= Service Point: 49 Charles Street, Cardiff
CF10 2GD (029 2066 4420):
reprographics, and some art supplies.
Student discount available with a student
card.

= Inkspot: the Old Church, Newport Road,
Roath, Cardiff CF2 1PU. Tel: 029
20490254 has an Art Shop, a Graphics
Shop and a Hobby Shop all under one
roof. Inkspot has the advantage of being
open on Saturday (9-5:30) and Sunday
(11- 4). Student discount available with a
student card.

Building Access

There is 24-hour access into the building which
is a real bonus and a concession on the part of
the University. Entry to the Bute Building
outside the normal opening hours (0800 to
2100 Monday to Friday, 0900-1600 Saturday,
closed Sunday) is through the South side
doors of the building. Your ID Card also acts
as a swipe card once it has been activated ay
the beginning of the year. If you are working in
the middle of the night, please be courteous
and helpful to the cleaners. If you do not want
your things to be thrown away make sure they
are on your desk and not on the floor.
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Working in the studio

Furniture

Tables are provided in the studios but you will
need to bring you own Al table top drawing
boards into the studio. These you will be
expected to purchase from the School.
Drawing boards with legs are not allowed in
studio as there is not enough space. Plan
chests drawers are provided for keeping
drawings safely. These you may have to share.
There are three pin sockets available if you
want to bring a desk lamp. All electrical
equipment for use in studio must first be
checked and approved by the IT
Administrator.

There is a computer in each studio together
with a scanner and a light box which are
shared between the rooms.

General Studio Rules

Studio Contract: All WSA students (excluding
4" year) are asked to sign a Studio Contract
are requested to pay a £25 deposit as an
agreement to keep the architecture studios in
good condition. This deposit will be returned at
the end of the year providing that the
expectations of the studio contract have been
followed.

To keep the studios in good condition there are
a few important requirements which everyone
is asked to respect:

Drawing Boards: The first and most important
point to make is that the drawing boards in the
studios are the personal property of each
student. It is therefore your individual
responsibility to look after them. They fit into
the plan chest drawers. Never use the straight
edge, on or off the board as a cutting guide.

Care of boards and tables: Please do not use
any cutting implement on the surface of either
a drawing board or a white topped table.
Whilst the tables may show scars of
inconsideration, you are asked to show a
responsible, professional attitude in the care of
materials. Use your green cutting mats, which
ensure a good quality cut as well.

Model Making: You will be expected to
purchase, from the School, safety office

approved model making tools. Light model
making may be undertaken in the studios but
power assisted tools must be used only in the
supervised workshop.

After any model-making activity, please clear
up the waste cards, paper etc. and put it in the
waste bins/sacks provided. We can tolerate a
lot of mess during a project, but please clear it
up afterwards. The University cleaners will
agree a studio cleaning strategy with us — the
general rule is that anything on the floor will be
cleared away by them, so ensure that models,
drawings, or anything that is to be retained is
kept on the table tops or window sills. Do not
use spray mount or other toxic chemicals in
the studio, the ventilation is not adequate.
Room 2.27 has been specifically designed for
this activity.

Noise and Privacy: Please do not play music
in the studio. Other people may be trying to
concentrate. We do not want to make students
feel that they have to go and work in their room
because they cannot stand somebody else’s
taste in music and they cannot concentrate.
Similarly you are asked not to use mobile
phones in studio. There are offices and
teaching spaces close by and please respect
the need for relative quiet when studio tutorials
and seminars are taking place. Please also
respect the quiet and privacy of researchers
and other staff who may be working in the
building at any time of the day or night.

Windows: Care should be used in operating
the windows. Try to follow these simple
operating instructions: the windows will open
narrowly at the top, when the handle is moved
from pointing down to horizontal, or more
widely at the side when the handle is pushed
up to vertical position. It is essential to close
the window and pull the handle right down
before attempting to change the opening from
one state to the other. Windows left open at
night can result in damage to drawings and
models as wind and rain enters the studio.

Kettles: are allowed in the studio only if they
have been tested for safety. Please make sure
you leave them in a safe place and that you do
not leave washing up lying around.
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Energy: If you are the last to leave, ensure
that all lights and ceiling fans are turned off.

Stewardship: Access to the studio is a
privilege. You are expected, in return, to keep
it neat within reasonable bounds. This means
appropriate use of the rubbish and recycling
bins, storing materials out of the way, keeping
pathways clear. Do not write/draw/ or in any
way mark on any surfaces. Do not cut on the
tables without a cutting mat. This will be your
home-away-from-residences for the year, and
you should treat it as the design professional
you hope to become.

Overseas study visits

Study visits are typically carried out in all
residential years and are a compulsory part of
the course. You must provide the travel
documents (passports, visa) needed for this
visit where necessary. We urge Non-EEC
passport holders to make enquiries now
regarding your need for a visa. Students are
expected to fund their study visit although a
contribution is often made by the School. We
will inform you of the estimated cost of the visit
early in the session. For further information on
the nature of the study visits in the school, see
section 4 of the Teaching Handbook.

Insurances: travel insurance arrangements
will be made by the University and included in
the overall cost. For time-tabled field work, site
visits and other visits as required by project
work you are covered by the University. You
are advised to obtain insurance cover for the
more valuable personal possessions which
you need during your work in the School. On
the overseas study visit it is also necessary for
EEC residents to get an European health
insurance card (EHIC). These can be
obtained from the post office, or online at
https://www.ehic.org.uk/
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How to Plot

Successful plotting takes time, preparation and
knowledge. Know what you’re doing to reduce
stress, save money and keep our plotters in action.

Plotting Checklist

1. Keep file sizes as small as possible

The smaller your file, the faster it will
print. Most of the time you spend
waiting is for your file to be sent from
the server to the printer.

Check the resolution of your files: we
recommend sending files no higher
than 200 dpi.

150 dpi should be fine. Higher resolutions
mean greater file sizes and dramatically
increased printing times.

2. Plot from PDF

Best practise is to save or export a
copy of your work as a PDF (from
whatever program you are using), and
then open the PDF in Acrobat to print.
It is quickest to print directly from the
D: drive of the pc, so save a copy of
the PDF which you wish to print onto
the D: drive, whilst saving the original
to your personal H: drive or portable
hard drive.

‘Optimize’ your file size in Acrobat Pro
to further reduce the file size before
printing (File > Save as... > save as
type Adobe PDF Files, Optimised
(*.pdf) > Settings).

3. Check Print Settings

Most problems result in the print being
rotated or cut off.

Double-check paper settings, page
layout and print-preview options before
printing.

. Collect your work

Please collect your plots in a timely
manner and discard all scrap paper
and draft prints into the green recycling
bins. You are responsible for your own
cleanup.

5. Give yourself enough time to plot

Allow plenty of time for plotting as it
always takes longer than you would
expect. Chances are everyone else
will wait to plot at the last minute; do
not make that mistake yourself. Plot at
least 24 hours before your deadline. If
necessary, do test plots days in
advance to check colour, quality, or to
familiarise yourself with plotting from a
new application.

6. Seek help if you need it

Ask other students who are more
experienced for help if you're out of
your depth. It is very likely that they
have experienced the same problem
as you, and will know a solution.
Problems related to equipment in the
computer labs or the plotter room
should be directed via email to
Architecturel T@cardiff.ac.uk, or to the
IT administrator based in the media
lab.

10
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Useful to know

The plotter room: The plotter room and
media lab are both 24 hour access. The
WSA is unique in permitting 24 hour
plotting, so please do not abuse this
privilege.

Printing dimensions: Plotters A, B, E + F
are Al. The roll is A1 width: 594mm.
Plotter C is AO. The roll is A0 width:
841mm.

Checking the print queue: Open the print
queue by going to Start, Settings: Printers
and Faxes. Double-click on the correct
printer to see the jobs in that queue. If you
see an error in your print job, or it seems
to be taking a long time, then click Cancel
and send your job again. Once a job
disappears from the server print queue it
will be stored in the plotter’'s own Job
Management Menu.

Topping up your print account: To
check the balance or add credit to your
print account, go to:
https://myprint.cf.ac.uk:9192/user or top up
with cash in any university library (the
closest is in Bute Library on the 1* floor).

Changing the roll and print cartridges:
If the plot roll or print cartridges run out
then please replace them with the supplies
provided in the plotter room, following the
instructions on the wall. Treat the plotters
with care and ask for help if you need it.
Report any problems immediately via
email to ArchitecturelT@cardiff.ac.uk, or to
the IT administrator based in the media
lab.

Sheet feeding: Sheet feeding is only
possible on plotters E + F, does not
require removing the plotter roll, but simply
‘unloading’ it. Follow the instructions on
the wall.

Printing files from: It is important to know
the difference between VECTOR-based
and PIXEL-based files. Vector drawings
are usually much smaller in file size than
pixel-based files. It is best to create your
presentations in Illustrator /

InDesign and place your Photoshop
images, adding text/annotations in the
layout programme. Avoid making whole
presentations in Photoshop. Files will be
much smaller and your job will plot much
faster.

Photoshop

e Control the printing resolution with
‘Image Size’ under the ‘Image’ menu.
Plotting higher that 240 dpi will not
result in a noticeably better quality
print; 150 dpi is normally adequate.

e Flatten all layers before printing. This
will reduce the time it takes to spool
the image. Save this as a copy as you
won’t want to lose your layers in the
original file.

e Convert images to ‘CMYK’ Mode in
Photoshop rather than RGB for
printing, since it corresponds exactly to
the print cartridges and will ensure
optimum quality for your print.

e You can print PDF, jpg and tif files
directly from Photoshop, but it is best
to save your file as a PDF to the D:
drive and to open this file in Acrobat to
print.

e To add additional memory using
external media (USB stick or external
HDD) go to Edit > Preferences >
Plug-Ins and Scratch Disks...

e To clear some memory go to Edit >
Purge, then choose to purge either the
Undo, Clipboard, Histories or all of
these features. Warning — once
purged the data used by these
features up to this point will be
irretrievable.

[lustrator

e Control the printing resolution when
you save to PDF under the
‘Compression’ settings. Plotting higher
that 240 dpi will not result in a
noticeably better quality print; 150 dpi
is normally adequate.

e Format your linked images in
Photoshop to your final desired output
size and to our suggested resolutions
(150dpi). Try not to scale the images
in lllustrator, which creates
unnecessarily large files and potential
printing problems.

e You can print PDF files directly from
lllustrator, but it is best to save your

11
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file as a PDF to the D: drive and to
open this file in Acrobat to print.

InDesign

Control the printing resolution when
you save to PDF under the
‘Compression’ settings. Plotting higher
that 240 dpi will not result in a
noticeably better quality print; 150 dpi
is normally adequate.

Format your linked images in
Photoshop to your final desired output
size and to our suggested resolutions
(150dpi). Try to keep all of the
imported images at the same
resolution as this will allow the files to
print quicker.

It is best to export your file as a PDF to
the D: drive and to open this file in
Acrobat to print.

AutoCAD

To lay out your sheets, use the
‘Layout’ tabs. Use the ‘Page setup’
settings (right click on the layout tab)
to set paper size and orientation. This
is also were you select the desired
plotter (or plot to PDF), and define
your line weights.

Make sure you define a viewport (or
‘plot window’) on your layout, and
zoom to the correct scale.

If you have use the free educational
version of AutoCAD (downloaded from
http://students.autodesk.com/), plots
will bear a watermark which says
‘Produced by an Autodesk Educational
Product'. It is best to plot to PDF from
AutoCAD, and then open this file in
lllustrator to remove the watermark,
before plotting the edited PDF from
Acrobat.

12
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IT Guide: For new students

Logging on

You will have been given your user name
and password upon registration you may
use this user name and password to login
to any school computer or any other
computer across campus.

Do not divulge your password to anybody
else or allow any other person to use your
account for any reason whatsoever.

To access CU-WiFi network

To access CU-WiFi from a laptop or
smartphone it must first be registered with
INSRV. To register your device, please
take it to either the Julian Hodge Study
Centre or the IT Clinic in the Students
Union (open 1pm-3pm Monday to Friday).
Visit
http://cardiff.ac.uk/insrv/it/network/wireless/
register.html for more details.

Email

Please check your Cardiff email account
on a regular basis as this is the only way
that we can get in touch with large groups
of students to pass on important
information.

You can access your email from any
internet-connected by opening a web
browser (e.g. Internet Explorer) and
navigating to https://portal.cf.ac.uk. Login
with your university username and
password and then click on the Email tab
to view your inbox.

Alternatively, redirect your mail to your
regular email address (e.g. Gmalil
account). Instructions for doing this can be
found at
http://mwehelp.cf.ac.uk/cardiffmail/cmfaqg.html

Software

Most of the software delivered by the
school can be found on the hard drive of
every PC in the Media Lab (Room 2.33) —
this includes the Autodesk Education Suite
and the Adobe Creative Suite found under
Start > All Programs. Additional software
is available under Departmental Software
and General Software.

Departmental software

This software is specific to the school of
architecture and can be accessed by
clicking on the Start button and then select
Networked Applications > Departmental
Software > Architecture. You will then
have various options to choose from.

General software

These are applications provided by INSRV
and can be accessed by clicking on the
Start button and then select Networked
Applications > General Software. You
will then see various sub headings please
take the time to browse through the
various headings to familiarise yourself
with the applications available.

Printing your work (see separate How
to plot guide)

Several large-format plotters are contained
in room 2.29. To print to these plotters,
use a workstation in the Media Lab (2.33)
or the Plotter Room (2.29).
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Printer location function

BUTE-229A-PLOTTER 2.29 Colour Al plotter
BUTE-229B-PLOTTER 2.29 Colour Al plotter
BUTE-229C-PLOTTER 2.29 Colour AO plotter
BUTE-229E-PLOTTER 2.29 Colour Al plotter
BUTE-229F-PLOTTER 2.29 Colour Al plotter
BUTE-233-BLACK 2.33 Black and white A4 (single-sided)
BUTE-233-COLOUR 2.33 Colour A4 and A3 (single-sided)

Please note that the charges for each printer are displayed on the machine itself, and A1 and AO0 will
be charged per sheet, not per plot.

contact the IT Administrator
Q+A (ArchitecturelT@cf.ac.uk, or INSRV
If you encounter problems with the above (insrvconnect@cf.ac.uk, 02920 874487).
or have any questions please feel free to
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5.00 Safety and Security

School Safety Contact:

As a student at WSA you have been granted
24 hour access to the School and your studio
by the University, this is a privilege that must
be treated with respect if it is to be retained.

To retain this level of access, the University
requires the School to demonstrate that all
activity is carried out responsibly and any
associated risk is managed. This is not the
responsibility of any one person but of
everyone in the School, staff and students, so
please familiarise yourself with these basic
requirements and refer any questions or
concerns to your Year Chair, the Facilities
Manager in T9, or WSA reception. Do not
leave it to someone else to report something
you believe to be a fault or hazard.

Studio Practice: The studio is a creative
workspace and it is your collective
responsibility to manage this space, and yours
and others safety, by co-operating with the
School on certain issues.

Use of Scalpels: You will be given instruction
in model making and the use of scalpels and
craft knives; do not use them until you have
received this tuition.

Always wear safety glasses when using with
tool, the tips of the blades have been known to
shap off when

pressure is applied causing nasty accidents.

Always cut away from the body and never
towards you, and use a cutting mat.

Always retract or cover the blade when not in
use, (it is easy to forget where you put it) i.e. in
your bag or hidden amongst materials.

Ensure you are totally confident in the fitting
and removal of blades; this is often when
accidents happen.

Dispose of all waste blades in the sharps bins
provided, do not under any circumstances put
them in the waste bins.

Carole Creasey, Facilities Manager room T.12

Be particularly careful when tired, do not rush
your cutting and do not allow yourself to be
distracted when cutting, a momentary lapse of
concentration can result in a visit to A&E.

First Aid Boxes

Know the location of the First Aid kit in your
studio and what you should do in the event of
an accident, particularly when working out of
hours.

All emergency numbers are located with your
First Aid kit, including the 24 hour security
number.

If you have an accident you will need to fill in
an accident reporting form, which is available
from T9 or WSA reception.

Security: Your student ID card will allow you
24 hour access outside of normal building
opening hours, via the side door at the end of
the bike racks. When entering the building
outside hours, wait for the door to close behind
you to keep the building secure and read the
Lone Working guidance in this section of the
handbook.

You should keep your studios locked when
unoccupied and be aware of thieves at all
times. Do not leave valuables unattended.
Lost items are handed in to reception so mark
your things with your name and mobile
number.

The University has a 24 hour control centre on
Park Place, report urgent incidents to them,
the number is on your First Aiders list with your
First Aid Box in each studio. Use your mobile
or the internal phone on reception or by the
front door.

Hazardous Substances: You are responsible
for reading the list of hazardous substances
and operating the required controls when using
items on the list.
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Familiarise yourself with the list of substances
accepted for use in studio and if you wish to
use a substance not on this list you must notify
your Year Chair and await their approval and
handling requirements. You must not bring
into studio or use in the School anything not on
this list or approved by your Year Chair.

Keep all aerosols in the yellow cabinets in
studio; they must not be left in the spray room
or your bag.

Spray Room — 2.27: This room has air
extraction fitted for using resins, aerosols, such
as spray mount and paint, or any work that
generates harmful fumes.

It also contains two wire cutters for working
with polystyrene.

It is used by all students and space is limited
S0 you must keep it tidy

Fire
In addition to the general information available
in the University, the School of Architecture

has specific modus operandi which also need
to be addressed.

The corridors, for instance, are used to display
work for examination purposes. Itis
imperative that the displays do not obstruct the
fire escape route and that drawings etc. are
securely pinned to the walls to minimise the
fire hazard. All work must be removed as soon
as possible after the examination.

Deadlines for the removal of work will be
displayed on the Year Notice Boards. These
deadlines must be strictly adhered to or the
work may be at risk of disposal.

During model making, all ‘dirty’ work, such as
the use of sprays, paints and solvents must be
undertaken in the designated room and not in
the studios or corridors. This room (2.27) is
situated in the west corridor. It is equipped
with a powerful extract fan to dissipate
potentially harmful fumes.

Managing the Risk

Familiarise yourself with the location of fire
exits.

Keep flammable waste to a minimum,
particularly in studio.

Do not store paper etc, beneath stairs in
studio; it could prevent the stairs being used to
exit in the event of a fire.

Do not leave furniture or work in the corridors
or near stairs. Return chairs to studio and pin
down work immediately after crits. Leaving
work on walls increases the fire risk and chairs
are a hazard when using the corridors to
escape.

You are required to keep all spray cans etc in
the yellow cabinets in studio. In the event of a
fire this will prevent an explosion. See
hazardous substance list for more information.

Do not wedge fire doors open.
Do not use electric heaters in studio

On hearing the alarm: Leave the building by
the nearest available exit

Do not stop to collect personal belongings. Do
not use the lifts. Go to the front of the building
and do not re-enter the building until told to do
so

Accident

First Aid for any minor injury is available,
during office hours from Susan Bowden in
room 2.53 and Bute Receptionists on the
ground floor. A First Aid box is also kept in
each studio. Alternatively you may seek help
from the Student Health Centre at 47 Park
Place (tel: 2087 4810) which

is open from 0900 to 1700 Monday to Friday.

An accident whether it causes injury or not,
should be reported to Carole Creasey either
personally or by Email on
CreaseyC@cCardiff.ac.uk).

24 hour access is allowed to the Bute Building
and therefore if an accident occurs after
normal working hours and you require
attention, phone Security on ex 74444. (029
2087 4444)
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Security.

The University does not take responsibility for,
or insure, the safety of items of equipment
which you own and use in the School. You
must take care of your own possessions at all
times. If you are the last person to leave the
studio, please make sure that you shut the
door behind you. There is a good community
spirit in the School and the studios are open all
day. Therefore they are vulnerable to
opportunistic pilfering by people who may look
like students. Do not leave your valuables
lying around. If something of value has been
stolen from you anywhere in the School, report
it to Carole Creasey immediately and alert
other students.

Please also take responsibly for your own
safety and inform security of any unusual
circumstances, or strangers. Security can be
contacted on ex 74444 (029 2087 4444)

Please be aware that the studios are cleaned
and cleared on a daily basis (prior to 8 a.m.)
and therefore it is extremely important that
your work is left on your work surface and not
left lying around elsewhere. The cleaners take
every reasonable care but it is sometimes
difficult to identify genuine rubbish.

Any concerns about Health and Safety or
Security within the School should be
addressed to either the Year Chair or
Carole Creasey.

Smoking

There is a no-smoking policy on all University
property so if you smoke please do this off
University premises.

Cleaning

Keeping the studios clean is a mammoth task
and our cleaning staff clean the whole School
in very limited time.

Black and green bins are provided in every
studio, please recycle as much as possible into
the green bins (paper, card, drinks bottles and
cans). Put your rubbish in the bin; don’t leave
it on the floor.

Studio’s floors are swept early, every Monday
morning; you are required to lift work and
materials off the floor to make this possible.

Lone Working in WSA Studios’
Remember to be safe and secure when
using the building outside office hours.
Bear in mind the context for these safety
instructions, the School does not have a
history of any out of hours problems with
security, however there are things students
can do to help maintain this position.

e Use common sense and the sort of
things you would do when going out at
night.

e First of all aim to work in pairs.

e When using the side door make sure it
is closed behind you before entering
the building when you are going in and
out.

e When entering via the side door
please sign-in on the clipboard on the
wall and indicate where you will be
working.

e Tell someone the time you got to
studio and what time you expect to be
back.

e Close the studio door; drop the latch
on the lock if you wish.

e Carry your mobile phone

e You can contact University security on
extension 74444, 02920 874444 put it
in your phone.

e Know your room number, any
concerns and please call security

See Control of Substances Hazardous to
Health list (COSHH List)
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6.00 Student Support

Personal Tutoring

In each year you will be allocated one of the core
members of staff as your personal tutor. Their
role is to keep an eye on your general academic
progress and to help you with any difficulties that
you experience during your course, whether
these might be academic or connected with your
personal circumstances. If you have any personal
worries or problems which might affect your
educational progress you should tell these to
your personal tutor. Such consultations are
entirely confidential.

Further information on the personal tutor system
in the school, can be found in section 8 of the
Teaching Handbook.

Other sources of advice

There are other sources of advice available
outside the School such as the Dean of Students’
office, 47 Park Place, Cardiff and the student
advice centre on the 3" floor of the Students’
Union. The University has its own Health Centre
also at 47 Park Place where you can seek
medical advice although you must register with a
General Practitioner. All guidance is free and
confidential.

Personal and Professional
Development Planning

Personal and professional development planning
(PDP) compliments your academic modules by
giving you the opportunity to record and reflect
upon your achievements and skills, think about
how you learn, consider your future plans and
plan and review your personal, academic and
career development. Opportunities exist for PDP
at all levels of the school, and these are detailed
in section 8 of the Teaching Handbook

Disability & Dyslexia

If you have a disability, dyslexia or a long term
medical condition, and want to talk to someone
about making any adjustments to the way in
which the course is delivered, or the way in which
you fulfil the assignments or any other issue,
please do not hesitate to talk to your year chair,

any member of staff, the WSA Disability
Contact or The Disability and Dyslexia Service
about it at any point in the year. We are
committed to providing an accessible
environment and therefore encourage anyone
who may have specific requirements which
arise as a result of a disability or medical
condition, to contact us as soon as possible, in
order that appropriate arrangements can be
made. The University can provide a variety of
services, including Disability advisers, Dyslexia
tutors, note-takers and a mental health adviser
and support worker service. To access these
services, call into the Disability and Dyslexia
Service.

You can reach the WSA Disability Contact,
Kate Docker, at DockerKAl@cardiff.ac.uk, ext
75970, room 2.58. The Disability and Dyslexia
Service in the University Student Support
Centre at 50 Park Place can also be contacted
any time on ext 74528, disability@cardiff.ac.uk,
and dyslexia@cardiff.ac.uk. As well as
appointments, the Disability and Dyslexia
Service offer an open drop in service from 1pm
4pm every Tuesday, Wednesday and Friday,
and also provide a range of informational
leaflets in their reception area.

If you choose to make a disclosure of a
disability the information you disclose to the
University will be treated with the strictest
confidence and normally, will only be passed to
staff members who are directly involved in
planning a response to your requirements once
you have given permission. If you have any
difficulties, even if they seem trivial, please do
come forward.

If you wish to request specific provision for
Examinations and Class Tests, it is essential
that you contact the Disability and Dyslexia
Service as early as possible, as specific
provisions for Examinations and Class Tests
can only be made on request via the Disability
and Dyslexia Service.

Full details on the Schools procedures for
dealing with disability and dyslexia can be
found in section 9 of the Teaching Handbook.
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7.00 General conduct and procedures you should know about

llInesses and Absences

Short absences You must become familiar
with the procedure for ‘self-certification’ of
absence due to illness. If your work has been
interrupted or delayed by iliness for longer
periods, and especially at important stages of
a project, you should obtain a certificate or a
note from your Doctor or the University Health
Centre (even if your Doctor charges a fee).
Hand in this certificate to Reception and let
your Year Chair know. Significant interruptions
of your work for other personal reasons should
be explained as soon as you can do so to your
Personal Tutor. You are responsible for letting
your Module Leader/Year Chair know of any
absence and if you have any medical or
personal circumstances that will affect or
disrupt your studies. Refer also to the
University academic regulations which can be
found online on the main University website.

Interruption of Study The University will grant
a “period of absence” to students who meet
certain situations which are likely to disrupt
their studies for an extended period. If any
such situation should occur which seems likely
to seriously affect your studies, then tell your
Personal Tutor, or contact the Student
Advisory service, as soon as you can. All
advice about your situation, and that of others
involved, will be confidential. Formal requests
for an interruption of study should be made to
the Chair of the Board of Studies.

You should note that the grounds for being
granted a period of absence are limited to
those outlined in the University academic
regulations. These are: ill health, parental
leave, exceptional professional work
commitments, compassionate grounds and
financial hardship resulting from a change in
circumstances.

Retention of drawings and
exhibitions

All drawings, theses, etc prepared in the
School or submitted for degrees or prizes are

considered to be the property of the School,
and students are admitted on this
understanding.

The public display of work of both students and
staff is an important part of the life of the
School and you will be expected to play an
active role in mounting exhibitions in and out of
the School.

Copyright of student work

The Welsh School of Architecture reserves the
right to take photographs of student work and
use it in producing the staff and student
handbooks, advertising events, the exhibition
catalogue, the Website, general advertising
and any other related purposes.

Students whose First language is
not English

All students who speak English as a second
language will be required to do a test to find
out whether they will need to attend extra
English classes which will take place within the
School.

Recording of Lectures

Lectures may be taped only with the
permission of the Lecturer, as it will be at their
discretion. Any recording will be for revision
purposes only and not for broadcast or
publication elsewhere.

If you wish to change to a different
course

If you decide that you prefer to study a
different subject within the University you
should firstly consult your Personal Tutor and
then submit a written request to the Chair of
the Board of Studies.

With first year students, this must be done
within three weeks of the start of the autumn
term. For continuing students this will need to
be within one week of the start of the autumn
term/semester
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8.00 Unfair Practice and the avoidance of plagiarism

Unfair practice is defined as a situation where

a person might obtain for him/herself or for

another, an un-permitted advantage leading to

a higher mark or grade than his/her abilities

would otherwise secure. Examples of unfair

practice might include:

= The introduction into an examination room
any unauthorised source of information;

= Communication with any other person
during and class test or examination;

= Copying or the use of unauthorised
materials or the work of any other
candidate:

= The impersonation of an examination
candidate

= Engagement in plagiarism by using other
people's work and submitting it as though
it were your own work

= Claiming to have carried out any form of
research which has not been carried out

by you or fabricating results.

Plagiarism®

It is an essential feature of good academic
practice that ideas or words taken from any
source should be properly acknowledged.
Students must follow this practice in all formal
written and graphic work.

The declaration of sources gives authority to a
statement; it shows that the author is not just
making an unsupported assertion, but has
researched the topic by referring to previous
published work and has chosen information
from a range of reliable sources.

It is common in architectural design to
reference the work of other architects and we
will often encourage you to study and analyse
precedent to inform your design projects, and
to provide inspiration. Nevertheless, where
this is done, it is important that you clearly
state the sources of any references made.

! Text based upon notes provided in handbooks issued to
students in the School of Computer Science, Cardiff
University

Any careless use of the ideas or words of
others without acknowledging them as such is
bad academic practice. Written work which is
found to contain a careless unacknowledged
guotation may be marked at a lower level. The
mark for written work in part reflects your
understanding of the subject being studied. If
you have merely repeated the words of
another, it is difficult to assess your
understanding and so to award marks for it.

Plagiarism, the unacknowledged use of the
words, images or ideas of others, with the
intention of passing them off as the author’s
own, is deceitful, dishonest and totally
unacceptable. Although our purpose here is to
help you to avoid plagiarism, you should be
aware of the consequences of being found
guilty of plagiarism. The Senate Regulations
covering unfair practice indicate the procedure
to be followed for cases of suspected
plagiarism and the penalties involved for cases
of proven plagiarism (see the Academic
Regulations Handbook). It is sufficient to
emphasise that the penalties for proven
plagiarism are severe.

To avoid plagiarism make sure that:

= you cite references correctly. You will be
provided with guidelines on how to
reference correctly. Guidelines are also
provided in the library.

»= you enclose in quotation marks any
material greater than four or five
consecutive words quoted verbatim from
the source even if it is unpublished

* you ensure that in written work you use
your own words wherever possible

= you cite sources for design ideas and
images/drawings used.

* you do not leave the completion of
coursework to the last minute thereby
increasing the pressure to cheat.

The university is able to analyse written work
for evidence of plagiarism electronically. If a
tutor suspects plagiarism, they will arrange for
such checks to be made.
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9.00 Assessment Procedures

Please note that University's Senate Regulations that relate to assessment and the classification of
awards are currently under review. You will be natified of any changes that impact on your
Programme of Study in due course.

The procedures for the assessment of your work are described in section 6 of the Teaching
Handbook. In addition each year you will be given a document which lists the modules you will be
taking and outlines the principal methods of assessment for each module.

The Teaching Handbook also contains a set of examination conventions which are the rules by which
Examining Boards determine the results for each candidate including:

= whether a candidate has passed or failed;

= the opportunities for retrieval of failure available to candidates;

= the classification of final awards.

These conventions are in accordance with the approved regulations for this scheme of study, a copy

of which can be found in the appendix to this handbook, and with the Senate Regulations for Modular
Undergraduate Degrees, which can be downloaded from the university web site.

21



wsa

Examinations through the
Medium of Welsh

Any candidate who wishes to be examined
through the medium of Welsh is required
to notify the Director of Registry in writing
by the end of week five of each semester.

Religious Holidays

Any student who anticipates that he or she
will be unable, on religious grounds, to
take examinations on certain days is
required to inform the Director of Registry
in writing within three weeks of the start of
each semester.

Examination Timetables

Timetables for class tests and/or
examinations will be displayed on the
second floor notice boards

Open Book Examinations

Where the method of assessment is
shown as an open book examination,
candidates will be notified in advance by
the School which approved books,
materials and documents they will be
permitted to take into the Examination
Hall/Room. These will also be indicated on
the front of the examination paper. Such
items shall bear no marks other than
underlining, highlighting, the name of the
owner and anything which is regarded as
normal in their nature or construction.

Use of Dictionaries and
Calculators in examinations

The use of non-electronic translation
dictionaries between English or Welsh and
a foreign language are permitted in all
class tests within the school

The use of electronic dictionaries is not
permitted. All dictionaries used in
examinations may be subject to scrutiny
by invigilators. If you wish to use a
translation dictionary in an exam, firstly
take the dictionary to your Year Chair who
will initial and date it, then take it to Jan

O’Brien or Sue Bowden who will stamp it
with the School and date stamp.

The use of scientific calculators is
permitted in all class tests within the
school

The calculators which students may use in
an examination must be noiseless, battery
or solar powered, scientific calculators with
numeric displays only. Programmable
calculators, or calculators with alphabetic
keyboard and/or the ability to store and
retrieve text are not permitted in any
examination or class test.

All calculators used in an examination may
be subjected to detailed scrutiny by
invigilators.

Marking by Numbers

It is not possible to anonymously mark
design project work. However when
marking class tests and examination
scripts, the identity of the candidate
remains unknown to the marker.

In an examination or class test, you are
asked to write your student number on the
front of your examination script. You
should write your name in the top right
hand corner of the cover of their answer
booklet(s) and you should then fold over
the corner of the cover where indicated
and secure with the label provided.

Penalties for the non-submission
or late submission of assessed
Work

All project work and coursework must be
submitted on the dates prescribed in the
project/course work documentation.
Students may be penalised, or receive
zero marks if work is not submitted by the
deadline without a bona-fide reason:
Please refer to section 6 of the teaching
handbook for details of the school’s
general policy on the late submission of
work.

Pass Mark

The pass mark for examinations is 40%.
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Special Circumstances will take them into account as detailed in

Where special circumstances have been section 6 of the teaching handbook

properly reported, the Board of Examiners

Determination of degree Re-Assessment

classification Candidates maybe referred for further

The final degree classification for each student examination in not more than 30 credits See
is determined by the Examination Board. Examination Board Conventions, in the
Guidance on how these are determined can be Teaching Handbook for further details.

found in the scheme regulations

wsa
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Appendix 1: Scheme Regulations

REGULATIONS FOR THE MODULAR SCHEME OF STUDY LEADING TO THE CARDIFF UNIVERSITY MASTER
OF ARCHITECTURE (M Arch)

1. GENERAL

These Regulations cover the second part of a five-year scheme of study in Architecture. The first
degree, BSc in Architectural Studies, and the second degree, with which these Regulations are
concerned, combine to provide a five-year programme of study comprising four years in residence
and one year of study predominantly in a supervised work placement, punctuated with short
courses at the School.

These Regulations are to be read in conjunction with the Senate Regulations for Modular
Undergraduate Programmes of Study.

2. DEFINITIONS

These shall be in accordance with the Senate Regulations for Modular Undergraduate Programmes
of Study.

3. ENTRY REQUIREMENTS

3.1 All candidates for admission to the programme shall satisfy the University's General
Entrance requirements and shall in addition:

(i) have obtained the degree of BSc in Architectural Studies from Cardiff University with a
minimum Second Class Honours; or

(i) have obtained an equivalent degree qualification in Architecture of an approved
academic institution and have satisfied the University that they are competent to undertake
a programme of study for the degree of M Arch.

3.2 A person who is not a graduate may at the discretion of the Head of the Welsh School
Architecture be admitted to candidature for the Master of Architecture where the candidate
is considered to be of the required academic standard to pursue a scheme of study for the
M Arch.

4, STRUCTURE OF THE PROGRAMME

4.1 The programme shall extend for two years and shall comprise twenty four modules (240
credits), including the following:

Graduate Diploma in Architectural Education

A period of time, equivalent to two semesters, of professional experience (Education in
Practice) in an approved organisation under the supervision of the Welsh School of
Architecture (120 credits at Level 3);
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8.1

MArch
Two semesters of academic study at Cardiff University (120 credits at Level M);

4.2 The Board of Studies may authorise the substitution of a year in residence for any
candidate who in the opinion of the Board of Studies has been unable, due to
circumstances beyond his/her control, to  arrange  suitable  professional
experience as described in 4.1(i), or for whom, having already had professional
training, a period of academic work would be more advantageous.

5. TIME LIMIT

The maximum time limit during which a full-time student may accumulate credit for the
award of a Cardiff University Master of Architecture shall be four years. The time-limit may
be extended in exceptional circumstances.

6. PROGRAMME OF STUDY
6.1 Year One: Education in Practice

(i) The period of professional experience is to be approved and supervised by the
Welsh School of Architecture.

(ii) During Year One the students shall undertake the modules detailed in the Module
Timetable schedule, all of which require the students to attend courses in the
School and to submit coursework.

(iii) A candidate who has been granted exemption from the professional experience
period under paragraph 4.2, shall be required to complete an academic
session in residence and during this time to prepare and submit academic
work as determined by the Board of Studies.

6.2 Year Two: Academic Study Period

(i) The programme of study for Year Two shall comprise the modules detailed in
the Module Timetable.

(i) The Candidates may be required to undertake visits, study tours or field
courses.

Examinations and Assessments shall be conducted in accordance with Cardiff University
Senate Regulations.

The method of assessment for each module shall be determined by the Board of Studies
and shall be specified in the approved programme documentation.

PROGRESSION

General
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A candidate shall be permitted to register only for modules in accordance with his/her programme
of study.

8.2

9.1

Year 1

(i) In order to proceed to the next academic stage of the scheme, candidates must have
completed the period of professional experience and passed all the component modules to
the satisfaction of the University, for which they will receive a total of 120 credits at level S.
(i) At the discretion of the Examining Board, a candidate who does not complete a
placement to the satisfaction of the University may be required to repeat the placement
concerned on one occasion only.

(iii) At the discretion of the Examining Board a student withdrawing from the Programme

after successful completion of 120 credits at level 3 or above, in MArch 1, will be eligible for
an Exit Award of Graduate Diploma in MArch

AWARD OF MASTER OF ARCHITECTURE

In order to qualify for the award of a Masters of Architecture, a candidate shall be required
to have obtained a minimum of 240 credits including at least:

--a minimum of 120 credits at Level 3 or above; and

- a minimum of 120 credits at Level M

The classification of degree shall be determined by the Examining Board at the end of the Spring
Semester in the final year of the scheme.

9.2

9.3

The final award for each candidate shall be determined by:

(i) calculating a weighted average mark for each module, as described in regulation 9.5
below, subject to the condition that, where a candidate has failed or been referred in a
module, the mark credited shall be the minimum pass mark;

(ii) in addition the Board of Examiners may award a pass with distinction or commendation
in accordance with examination conventions 9.4 below

The classification shall be determined in accordance with the procedures described in

Senate Regulations for Modular Undergraduate Programmes of Study and shall be based upon the
performance of each student in the Year Two modules, specified in the Module Timetable and in
accordance with the weightings

Subject to the following restrictions:
(i) the overall time limit of four years for the completion of the Masters of Architecture,
(ii) In order to be awarded credit for AR5001 Design Thesis, candidates must achieve

a mark of 40% or higher in the Final Design Project element of this module (this
element accounts for 75% of assessment for the module).
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(ii) AR5002, the Dissertation module, will be assessed at the end of the Autumn
Semester, and the Examining Board (which includes all the Dissertation External
Examiners) at that time will award a pass or fail decision for that module. Normally
Students who have achieved a mark of between 35% and 39% will then have the
opportunity to resubmit their dissertation for assessment prior to the Spring
Semester Examining Board. The three MArch External Examiners, plus one
representative of the Dissertation External Examiners, will look at the dissertation
prior to that Board meeting. The Examining Board shall determine whether the
candidate has passed or failed the module. The 40% maximum rule applies.

9.4.  The final degree classifications for each student shall be determined by the Examining Board by
applying the students overall result, which is calculated in accordance with the weightings, to the below:

9.4.1 Normally, to achieve the award of commendation, a student must gain a mark of 70% or more
in the Final Design Project element of AR5001 Design Thesis or in AR5002 Dissertation, as well as
having an overall average of 65% or more.

9.4.2 Normally, to achieve the award of distinction, a student must gain a mark of 80% or more in the
Final Design Project element of AR5001 Design Thesis as well as having an overall average of 70% or
more.

9.4.3 Inorder to pass AR5001 Design Thesis, candidates must achieve a mark of 40% or higher in
the Final Design Project element of this module (this element accounts for 75% of assessment for the
module).

9.5  The Examining Board shall determine whether a candidate:

(i) has qualified for the award of a Cardiff University Master of Architecture;

(i) has qualified for the award of a Cardiff University Master of Architecture with
Commendation;

(iii) has qualified for the award of a Cardiff University Master of Architecture with Distinction;
(iv) has not qualified for an award;

(v) has qualified for a Graduate Diploma in Architectural Education, at the discretion of the
Board of Examiners

A candidate who fails to qualify for the Master of Architecture shall be dealt with in
accordance with paragraph 10 below.

10. FAILED CANDIDATES

A student who fails to qualify for the award of degree with a distinction, commendation or a pass
degree shall be dealt with in accordance with Senate Regulations for Modular Undergraduate
Programmes of Study.
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Once the Examining Board has determined the result of each candidate in each resit/repeat module
it may further determine whether:

(i) he/she shall be advised to withdraw from the programme of study;
(ii) he/she shall be required to withdraw from the programme of study.

A candidate who passes a module in which he/she has previously failed or been referred
shall be credited with the minimum pass mark only.

A candidate shall only be permitted to continue to pursue the Master of Architecture providing that
he/she is able to complete the programme, and do so within the overall time limit of four years.
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